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B2GNe\Y Vendor Quick Guide

Welcome to the B2Gnow system.

Historically, compliance tracking has been extremely inefficient with time consuming
manual processes and paper forms. The B2Gnow system streamlines compliance
tracking by streamlining and automating these processes in an intuitive online system.
You will receive all your compliance notices via fax or email from now on. You will be
provided with a username and password that will allow you to access the system 24
hours a day, 7 days a week to view your contracts, report payments, and track goals.
You will quickly realize that the system was implemented to make compliance quicker
and easier for vendors.

For support, please contact your local agency, visit the online forums, or click on help
from the system menu. Please make a note of who your Contract Compliance Officer
is for each of your contracts, because they will be a valuable contact for your project.
They will help you with any disputes or questions regarding payments and contracts.

About this Training Manual

We have developed this User Manual as a full, in-depth guide to the system. This
Manual will start with the overview of the system, how to navigate through the different
modules and lead into showing you more advanced functions. You will be provided
with step-by-step instructions, visual aids, short cuts, advice and tips so that you can
get the most out to of the system.

Chapter One: Looking over the system

Chapter one is a run down of the system. It will provide a guided tour of the
basic functions, navigating the system, doing searches, and running reports. By
the end of this section you will be able to navigate through the system and
manage your account.

Chapter Two: Getting things done

This is where we will really start to get our feet wet by actually viewing contracts,
concessions and certifications. You will learn how to use the system to edit
various parts of contracts and audits. This is where you will start to communicate
with vendors, both Prime and Subs. By the end of this section you will be able to
perform the basic functions for managing contracts, concessions and
certifications.
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How to use this manual

This training manual is divided into chapters based on level of complexity. We kept the
basic and easy in the beginning working toward the more complex functions. You can
choose to read this manual from front to back, or you can choose to use is as a
reference. You may use the highly detailed Table of Content to simply find the subject
you are looking for and go directly to that topic without having to leaf through the other
sections.

It is best to use this manual while you are logged into the system. We find you will learn
the functions better and faster by actually performing them yourself. Your contracts
might not be exactly the same as the samples in this manual, but you can do the same
functions with your own contracts as the ones shown in this manual.

In this manual, we have tried to provide the easiest and best way to use the system.
Unlike any other application, the method we show you might not be the ONLY way and
as you learn the system better you will find and use shortcuts or perhaps you might like
to have the left menu fully expanded for easier access to tasks. As long as you are able
to complete your tasks and the data is correct and accurate, then we encourage you to
use the method that works best for you.

Security FAQ

The system is extremely secure. When you log in, you are assigned a unique,
temporary identifier. The identifier will expire within four hours. Using the system will
refresh the expiration of the identifier, so that you can continue your work. When you
are finished, we recommend logging out before you close your Internet browser. This
will delete the identifier, preventing someone from using your computer to gain access to
your account.

Your data is protected at all times. It is stored on top-of-the-line servers that are
protected by multiple hardware and software firewalls. Confidential data is protected by
industrial-strength encryption.

No other users can access your account. Your username and password are unique.
NEVER give these to any one else. If someone in your organization requires access to
the system, you can set up a new account for them. Other users in your organization
can see the same information as you, depending upon their access settings.
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Chapter 1: Looking over the system
Overview of the System

A vendor can be a prime on one contract and a subcontractor on another. In addition,
a vendor might be certified by any number of organizations that use the system.

Account Type

Vendor

1. Maintain contact information up to date in system.

2. Must complete contract and/or concession audit lines to stay current.

3. If prime contractor, close contract audits when all info is reported and project is
complete.

4. If subcontractor, must mark work as complete when final payment is made and
they are no longer working on project.

Types of Notifications

The following is a list of automatically generated notifications sent to the users by the
system.  Replying directly to these notices will reach a Customer Support
representative; however, in more complex cases it is best to contact the Contract
Compliance Officer directly. Their contact information is usually included in the body
of each of these natifications.

e Contract or Concession Monitoring Notice
e REMINDER - Contract or Concession Monitoring Notice
e Unresponsive Subcontractors Notice
e Discrepancy Notice
B2Gnow Support © 2006 B2Gnow
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Getting Started

How to receive your username/password

System Access Login When you visit your
y _ * Abaut the System MWDBE site you will see a
semame. I s Infarmation for Staff : :
, log in screen that looks like
) e Information For Yendors >
Password: | this.

e Yendor Registration

Login
4' o Contact Us, Support CIle on Forgot

Forgot Password : : .
Bascunrd Looky * Terms of Service, Privacy Policy Password.

Help/First Time Visitors

Type in your email address

Password Reminder and click on Submit.

Enteryour email address, username, or user numbet in the box below and we will send your
password to your registered e-mail address or fax number. Ifyou do not know your ugernarme

you can lookit up. | Within a few minutes,
check your email. You
should have a notice that
| Submit |

contains your username
and password.
*In most cases your username and your email address will be the same.

In some cases, you will have to send a username/password to vendor.

System Access Login

e About the System

e Information for Staff
Pascward: I e Information For Yendors Click on Password

* Yendor Registration Lookup.
Login |

Forgot Password
Password Lookup
Help/First Time Visitors

Username: I

* Contact Us, Support
* Terms of Service, Privacy Policy

S —— A sea_rch screen will load.

Business Mame JO& Construction| Type In your Sear(?h
parameters and hit

Contact Person First: Last: Search

Email

Phone Mumber Note: You mlght have to

Fax Number be specific, or more vague

with your search

Address A
_ depending on your search
o results.
StateiProvince | ar
G=D
B2Gnow Support © 2006 B2Gnow
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Search Parameters

Business Mame
Contact Person
Email

Phone Mumber
Fax Mumber
Address

City

StatesProvince

Search Results
Business

J.OVAL Construction
Cormpany, Inc

J.CvAL Construction
Cormpany, Inc

JOA Construction

First: Last:

Search

Contact Person  Contact Details Se_nd
Reminder
Johnson Akinwusi Pt 713-490-7591 Send
Fi 713-420-73935 A
E:johnson@joacon.carm Reminder
At 4151 Southwest Freeway, Ste.
220, Houston, TH
Renee Phelps Pi 713-490-7591 Send
F: 713-490-7595 q
E: rphelps@joacon. com Reminder
A 4151 Southwest Freeway, Ste,
220, Houston, Tk
< Top

From the list of results, find
the person to whom you
want to send the reminder.
Click on Send Reminder.

With in a few moments,
they should receive a
username/password
notice.

Note: If they do not
receive a username/
password notice, it could
be that their current email
does not match the email
in the system. Re do the
search and verify the email
address. If it is incorrect,
you will have to edit their
email address. See
Editing Vendor
Information.

B2Gnow Support
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Logging in for the first time

Once you receive your username and password you are ready to get started.

System Access Login

Visit the MWDBE site and
s about the System

Username: |

type in your username and
password into the

* Information for Staff

Pagsword: I

Login |

Forgot Password . . .
Password Lookup * Terms of Service, Privacy Policy

Help/First Time Visitors

* Information For Yendors
* Yendor Registration

designated fields. Click on
Login.

s Contact Us, Suppart

The very first screen you will see is our Welcome Page.

-

B2GNeWw

& = S
| 9
Home
View »

Search »
Reporting Tools
Tools »
Message »

Edit Settings »
Help & Support »
System »
Logoff

Show All - Hide All
Logged on as:

Cavn Raymond,
B2Gnow

- Welcome to our system!

Cur systemn is designed to make data gathering simplier and faster. Please review the information below before continuing to ensure that vou
maximize your

Security
» Change your password immediately if someone else set up vour account.
» Do notuse someone else's account. Every person must have their own account. Ifyou do not know how to setup a user account, please
comtact us thraugh the messaging systern: from the left menu, click Message, then Contact System Support.

Navigating
» All systemn functions are availahle fram the menu on the left. Just click any of the topics to view the subitems. This menu is visible at all times.
» The page you will see after this welcome sereen is your dashboard. It provides a quick summary of your assigned records, and identifies if
immediate action is reguired.

Finding Records
» Ifyou need to find a particular recard (contract, vendar, user, cerification), the best place to start is Search. From the left menu, click Search,
then selectthe type of record you need to find. Fortips on searching the system, download the Quick Guide listed below.

Help & Support
» Download the support guide in PDF format - Download Support Guide
» More help options are available from the left menu under Help & Support, including our online help systern, a Forums module, and
messaging tools.

Continue |

[T Do not show this page again

Customer Service Horne | Help | Print This Page

Copyright @ 2006 BEGnow, All rights reserved,

Please take the time to read the information on this page. Under help and support there
is a PDF downloads, the Vendor Quick Guide. This guide can be used as a quick
reference to the system. They are laid out in an FAQ format and is no longer than 14

pages.
B2Gnow Support © 2006 B2Gnow
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Your Dashboard

After clicking Continue on the Welcome Page you will automatically be taken to your
Dashboard. From this page, you can pretty much link to anywhere in the system. The
Stat chart in the middle shows you a quick highlight of what is going on with your

contracts.

The items in RED are issues that need your immediate attention.

To

immediately address the issues in RED, simply click on the link and it will take you
directly to the page where you need to go to resolve the issue.

My Contracts 2 BLE
Total active (husiness) 4 Configure co
BZG NOW Active assigned to ma i} Dashboard Change Your Password Business Info
Audited 4 EditYour Settings Frofile Setup
- el ListUsers Account Preferences
s = & Soonto end (3 mo) 2 Add MNew User Commodity Codes
Quid 5 Last 2 Last & Last 12
GO
S | > ik Ml menths | menths | menth:  Frequently Used
Home Total Audits 2 2 = Change your password
. Search for subcontractors
Views » Incomplete Audits » Z 2 3 Viewall incomplete audits
Search » Incomplete Audit Lines » [} [} a9 Wiew recent audit discrepancies
’ ) Wiew all of my contracts

Reporting Tools AU DTSR EES U U u Wiew ry cettifications

My Certifications Active Pending Expiting Eenarting
Tools » = 7 7 7

atus iea o

Message » Customer Service [=]
Edit Settings »» .

System What's New =] Messaging
Help & Support »

Help & Support - - Send a Message
SR Sysiam Status Board === Download the |atest Quick Guide in PDF farmat. Cortact System Support

Site hiap Repott a Frablem
Logoff File Download Area Submit Feedhack

Show All Hide All

Logged on as:
Dawn Raymond,
B2Gnow

Copyright @ 2006 B2Gnow, All rights rezerved, Privacy Policy | Terms of Service

]

Please take the time to look over the Dashboard and to find out where all the links go.

B2Gnow Support
support@b2gnow.com
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B2GNe\Y Vendor Quick Guide

Exploring the Left Menu

When you log in to your account, the menu on the left provides quick access to all functions in the system. Click the
main categories to reveal additional sub-items, and click those items to link to the selected function in the right display
window. Note: As new functions are added, the menu system is extended and sometimes rearranged for efficiency.

View »
My Contracts
My Contract Audits
My Certifications
My Concessions
My Concession Audits
My Outreach Projects
Messages
Search »
Vendors
Certified Vendors
Contracts
Concessions
Outreach Projects
Users
Message »
Send a Message
Contact Support
Submit Feedback
Report a Problem
Edit Settings »
Change Password
Your Settings
Business Settings »
Business Info
Vendor Profile
User List
Add a User
Account Preferences
Commodity Codes
Subscription Services
Help & Support »
Help System
Forums
Vendor Quick Guide
Vendor Training Manual
Contact Support
Submit Feedback
Report a Problem
System »
System Status Board

Contact B2Gnow
About B2Gnow

= Go back = Go forward Refresh the page é Print the page

Enter a search term and click Go to search the contract, concession, outreach, vendor, and user
databases. Because all data types are searched, this can sometimes take longer.
Return to the main page of your account. You can also click the logo in the top left.

A listing of your contracts.

A listing of your contract audits.

A listing of your certifications.

A listing of your concessions.

A listing of your concession audits.

A listing of outreach available to you.

A listing of the messages you've sent and received in the system.

Search the entire vendor database.

Search the certified vendor directory.

Search the contracts database.

Search the concessions database.

Search the outreach projects database.

Search for a specific system user (staff or vendor).

Write and send a message to any system user.

Get help with using the system.

Contact us with your thoughts and suggestions about the system.
Report to us an issue that you're having with the system.

Change your password.
Update your user account settings.

Update your business information.

Update your vendor profile.

View all authorized users in your business.
Add a new user to your business.

Update account preferences for your business.
Update commodity codes.

Manage value-added subscriptions.

View the online help for the system.

View the online forums/knowledge base.

Download the Vendor Quick Guide in PDF format.

Download the Vendor Training Manual in PDF format.

Get help with using the system.

Contact us with your thoughts and suggestions about the system.
Report to us an issue that you're having with the system.

Check the status of the system, including listings of maintenance and upgrades.
Contact our team.
View information about the software that powers the system, including version information.

Logoff Log off from the system.
Show All Hide All Click to show or hide all of the menu options listed above
B2Gnow Support © 2006 B2Gnow
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Search Tips for the System

e Start with one parameter. Usually one, and sometimes two parameters, is sufficient
to find the record you are looking for. The more specific your search terms, the more
likely the record will not match the terms due to spelling, order, or other variations.

o Keep the search parameters short. Use ACME instead of ACME Construction, Inc.
You can even use partial words, such as envi instead of typing environmental
consultant.

e The system will ignore punctuation. C & C is treated the same as C and C; C. C. is
the same as C C.

e Become familiar with the possible settings and options. The record you are seeking
may not be displayed because you have selected the wrong option. Or too many
records were returned because you did not narrow the search parameters.

o When searching for businesses that are named for their founder, such as John
Smith & Co., it may be listed as John Smith and Co. or Smith, John and Co. You
may need to search for both versions. Start by searching just for one of the names,
such as Smith.

e The search is not case sensitive. ACME is treated the same as acme.

e When searching by first name, be aware that users may be listed by alternate
names. For example: James, Jim, Jimmy, or J

e When searching by contract or project number, where you are typing a specific
reference, your number must be exactly correct. It does not have to be complete
(type C53 to view all contracts that have C53 in the contract number, such as C531,
C532, C53B, C53980 etc.), but C53 will not find C35.

Search: Users @ e
Users |Vend0rs I Contracts | Concessions I
Enter search parameters and click Search. The mare specific the terms, the maore limited the results. If unsure aboutthe exact
name of a person ar an arganization, enter part ofthe name.
Search First 20 Matches | Search All Matches | Clear Form |
Organization |
First Name |
Last Name |
User Type  Buyer
' Diversity user
 vendar
User Humber I—
Email [
Phone I— l—
Fax —
Address |
City [
StateProvince | j ar |
2 Tap
Search First 20 Matches | Search All Matches Clear Form
B2Gnow Support © 2006 B2Gnow
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Configuring your settings

Change your Password

After first logging into the system, you might be prompted to change your password.

-

B2GNeow
= = =

Seare: | <

Home

Views »

Search »

Reporting Tools

Tools »

Message »

Edit Settings »»
Change Password

Your Settings

Business Settings »

Help & Support »
System »
Logoff

Show all - Hide All

Logged on as:
Dawn R

Yendor Console: Change Password @ e

“ou can select a new password, which must be between 3 and 15 characters, and can include letters and numbers.

Make your password something easy to remember, but difficult for others to guess. For security purposes, it's a good idea to change your
password every month.

Donot make your password the same as your username or your first ar last name, as these are too easy for an intruder to guess. Never share
your password with anyone else. If another person in your arganization needs access to the systern, please contact us, and we can show you
how 1o setup a an additional account for them.

When you change your password, you will receive a confirmation email or fax. You can also contact B2Gnow to get your passward reset.

* required text

Old Password * |

New Password * I

Type New Password Again * |

Save Cancel |

L Service

B2Gnow

Horne | Help | Print This Page
Copyright @ 2006 B2Gnow. All rights reservad.

1. From the Edit menu, click Change Password.
. In the Old Password field, type your old password.
3. Inthe New Password and Type New Password Again fields, type your new

password.

4. Click Submit.

Your new password is effective immediately.

B2Gnow Support
support@b2gnow.com
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Editing your Settings

Depending upon your access settings, you may be able to update your account settings.

-

Busi 5

Yendor Console: Business Information

e HELF

Commaciity Codasl Accourt Prefs | Certifications

Contracts | Concessions ! ’

B2GNe
& =

cancel any changes.

Quick I— * required entry
Search:
Home Business Information
View »
. numhbers if you move.
. Business Name *
Reporting Tools
Tools » DEA Name
Message » Main Company Email *

Edit Settings » Main Phone *

hange Password
“Your Settings
(Business Settings =Y
General Business
Information

Vendar Profile

Main Fax™*
Main Company Website
DUNS Number

Tax ID Humber
User List
Add a User Company Type

Company Ownership Ethnicity

Account Preferences

Commeslsy Eodlas Company Ownership Gender

Below is your general business information and classification. You can edit any entry. Click Sawve Changes when finished, or click Return to

Your business information is provided to buyers whenever yvou submit a hid or send a message. Don't forget to update vour address andior phone

?

|EIEGn0W

ICDEI| Beans

|sa|es@b29now.cam

oz [s259277 e[
[0z [e5eer7

|http {Mwereer D2gnow.cormy
I—

[e7aarse
[Jointvenue =]

Subseription

Services

Help & Support »

System »

Logoff Business Classification
Show All Hide All

husinesses. Ifyou are in one or mare ofthe
programs or considerations.

Select the classifications that apphy to
your husiness

(Chedk all that apphy)

Clide here for olassification guidelines

Logged on as
Dawn Raymond,
B2Gnow

If you are a Minority Business Enterprise,
select minority category

[ <]

Certain husinesses, as defined by United States law, are considered disadvantaged businesses. Many governments provide incentives o these

=Top

Save Changes | Return |

?
following categories, you can check the appropriate hox to ensure that you are included in any special

[¥ Small Business Enterprise (SBE)

¥ woman-Owned Business Enterprise (WBE)

¥ Hub Zone

¥ 8(%) Firm

[ Disabled Veteran Business Enterptise (DVBE)

[¥ Persons with Disabilities Business Enterptise (PDBE)
[+ Minority Business Enterprise (MBE)

General Minorities
& African American

Asianh Pacific
= Japan

Navigate the tabs to view and edit your'“company’s information.

B2Gnow Support
support@b2gnow.com
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Adding a User

Under the User Tab, click the Add User button.

Vendor Console: Users @ rer
Business Mame: B2Gnow, cea Cool Beans
Mainl General Infol Profilz Users ICommodﬂx Codesl Accourt Prefs | Certificaﬂonsl Cortracts Concessionsl

Listed are all ofthe users accounts for this business. To view a user's information, click the user number ar name.

Add User |

User Humber Hame Title Contact Role{s) Dlﬂitf

20000279-013 Raymond, Dawn Prevailing YWage Copy --

20000279-001 Samson, Jr., Rohert Cerifications, Contracts, Copy
General, lmvaicing, Cwner, Delete
Sales

Type in all the information and set up their account preferences, then click Save.

* required entry
Contact Information ?
Enterthe uzer's contact information. The email addrese senes as the the username

Name * I I
(first, last name]

EmaillUsername * |

Title

Phone Number * | Ext. I

|
|
Fax Number * [
|
|

Choose password *

Retype password +

2 Top

Addresses
Selectthe addrasses for this user. To edit or add addresses, click the Contact Info tab at the top ofthis page.

‘

Physical * |Se|edaphysical address j
Mailing * |Se|ectama|lmg address j
Billing * |Se|ectab|l||ng address j
Shipping * |Se|ectashipping address j

= Top

Account Preferences
Selectthe timezone, language, and notification settings for this user.
Time Zone IUS,-"CentraI j

Preferred Language * IEninsh 'l

‘

[POrE e I B i () Email AND Fax: |Send me plaintextemail x|
Email: ISend me plain-text email j
Fan

Notification Options Motify me of new system features, sarvices, and special offers. Uncheck the box to not receive these notices.

N e Se Tle

Motify me of government communications, such as seminar and training bulletins. Uncheck the boxto not
receive these notices.

Save | Return

2 Top

B2Gnow Support
support@b2gnow.com
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Editing a User

Emails and contact information changes. It is very important to update your account as
soon as possible so that the system has your correct information.

To the User list and click on the person you want to edit.

User Humber Hame Title Contact Role(s) Delete User

20000279013 {(Ravmond, Dawn ") Frevailing Wage Capy -

20000273-001 Samson, Jr, Roberf Cerlifications, Contracts, General, Copy Delete
Invaicing, Owner, Sales

Then edit their information according to your new information. Click on Save changes
when complete.

* required entry

Contact Information ?

Enter the user's contact information. The email address serves as the the usermname.
'(iiarr:l?l:st REDES |Dawn |Raym0nd
EmailUsername * |dawn@h2gnow com

Title [

Phone Number * [poz  |325-9277 Ext |

Fax Number * W IW

& Top

Please Note: When you change your email, your username also changes.

If your email has changed and you have forgotten your password, you will have to
contact customer support to retrieve it. When emailing customer support, please include
your full name, company name, phone, fax and new email address.

B2Gnow Support © 2006 B2Gnow
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Sending Messages

A great feature to the system is the ability to send email messages to other users. It is
an easy way for you to contact your Contract Compliance Officer about an issue without
having to use an external email program.

Messaging: Send a Message to Customer Support @ rer
Send a Message  Contact System Support ISubm'rt Feedback | Feport & Prakilem | Request a Callbhack |

Usethis page to send a message to a B2Gnow representative. Select the recipient(s), enter your messade, and
attach a file if needed.

* required entry

Send this message to * [ Market Administratar
[T Account Manager
[T Customer Serice Representative
[T Technical Support Representative

Message Subject * |

Message * ﬂ
Attach File Attach File |
& Tap
Spell Check | Save | Cancel
Customer Service Horme | Help | Print This Page

Copyright @ 2006 B2Gnow, All rights reserved,

You can contact System Support, directly without having to look for an email address.

B2Gnow Support © 2006 B2Gnow
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Messaging: Submit Feedback [ B

Send a b | Contact System Support  Submit Feedback |Report & Problem | Reouest a Callback

Wie appreciate your feedback. Suggestions and comments help us understand your requirements, so thatwe can
continue to uparade the system with new features and robust applications.

Use this form 1o send feedback to B2Gnow. Enter your feedback, identify a related process orweb page, if applicable,
and attach a file ifneeded.

* required entry

Message Title * |
ProcessiVeh Page |
Feedback * ;I
Attach File Attach File |
A Top
Spell Check | Save | Cancel
Messaging: Compose Problem Report (2 PO

Send s Message | Cortact System Support | Subimit Feschack Report a Problem |Request s Callback |

Use this form to report problems with B3 Gnow to your marketplace administrator. They will take action and respond to
your report.

Fillin as much information a5 possible and use the additional information box to describe how the problem occurred.

*fou can attach any documentation or a screen capture of the problem (hit the PrtSen key and paste into a Word
docurnenty

* required entry

Page Name * |

[ EH

Date of Problem *

You can submit feedback
to let us know how we
can better improve our
system.

You can report a
problem. The more
information given about
the problem the faster we
can address the issue.

;;.“;ju:[:l;::uin at the time? SR = We deﬂmtely encourage
all users to report any
bugs in the system they
= might find.
Describe the Problem d
We are constantly
working with the system,
T s j doing improvements and
making it better.
;I
Attach File Attach File
Spell Check | Save | Cancel
B2Gnow Support © 2006 B2Gnow
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